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Fig. 1: Misland Homepage

MISLAND Africa is an operational instrument relying on the international standards for reporting SDG 15.3.1 and
technical approaches allowing the delivery of regular information on vegetation cover gain/loss to decision makers and
environmental agencies at the first place.

The core-service provides land degradation indicators for five African Countries at two levels:

• At the regional level where low and medium resolution EO are used.

• At the pilot site level, where(customized indicators) can be developed, using medium resoultion data(landsat
time series imagery and derived vegetation indices, combined with different satellite-derived climate data)

Note: You can download the PDF Version of this doucument here.
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https://misland22-data-documentation.readthedocs.io/_/downloads/en/latest/pdf/
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2 MISLAND SYSTEM ADMIN



CHAPTER

ONE

MISLAND SYSTEM ADMIN PANEL

The following document is a system administrators manual that gives information on how to configure and manage
the system. The backend of the system is built on django and therefore features the general characteristics of Django-
admin settings. From the admin panel, the system administrators can manage dataset, users, and system resources thus
ensuring that the computing resources are well utilized while still maintaining a high level of data security and integrity.
The components of the system are described in details in the sections that follow.

1.1 System Setting

System settings can be accessed by going to System Settings and then click the item under Email Host. From here you
can set several variables that are key to system resources management. One of the variables you can configure from
here is the maximum size of a polygon that can be processed by the system on the fly.

3
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Fig. 1: Vegetation Qulity Index model outputs

1.1.1 Guest user polygon size limit

Use this function to limit the size of the area for which unregistered users (Guest) can process data on the fly. The admin
of the system can choose to turn off this option and therefore allow guest users to process large amounts of datasets on
the fly.

4 Chapter 1. MISLAND System Admin Panel



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

Fig. 2: Guest Polygon Size limit

1.1.2 Signed up user polygon size limit

This limits the maximum size of an area a registered user can compute on the fly. Registered users have the option of
scheduling processing tasks that use datasets that cover areas larger than the set polygon size limit. Tasks scheduling
can be enabled/disabled by checking/unchecking the Enable tasks scheduling option.

1.1. System Setting 5



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

Fig. 3: Guest Polygon Size limit

1.1.3 Enable user account activation

When this option is turned on, a verification email is sent to every user who registers with the system. This ensures
that users only register with emails that they have access to, and are therefore able to get notifications related to their
activities within the system.

6 Chapter 1. MISLAND System Admin Panel
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1.1.4 Email, URLs and host email host port setup

These options are crucial for connecting the backend to the frontend and are most likely to be setup only once during
the initial system setup. Here you can set up the different emails required to ensure smooth working of the system.
In addition to setting up the email urls, you can configure the raster clipping algorithm that is used when performing
computation under Raster clipping algorithm option.

Fig. 4: Email, URLs and host email host port setup

1.1. System Setting 7
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1.1.5 Enable Cache Limit

The system features a cache that enables the system to store pre-computed outputs of the system. The Cache limit is
set in seconds, which indicates how long the results should be stored in the system once they are computed.

Fig. 5: Enable Cashe Limit options

1.1.6 Backend port

The system is designed to automatically generate a backend port, but it can be set manually by checking the override
backend port option. When all configuration for the system settings are done, click the Save button to apply all the
changes made to system settings.

Fig. 6: Enable Cashe Limit options

8 Chapter 1. MISLAND System Admin Panel



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

1.2 Scheduled Tasks

As mentioned before, the system enables users to schedule tasks that involve computation of relatively large dataset.
To view all the scheduled tasks, select the Scheduled Tasks option in the admin panel. This option lists all scheduled
tasks with information related to the tasks, including who scheduled them, when they were scheduled and the current
status of those tasks.

Fig. 7: Schedule task

1.2. Scheduled Tasks 9
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1.3 Uploading and Manipulating data in the system

The Raster option enables system admin to upload, filter, delete and edit the raster datasets.

Fig. 8: Uploading rasters

10 Chapter 1. MISLAND System Admin Panel



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

1.3.1 Uploading data set

To upload the dataset, click on the Add Raster button. This will open a data upload panel that will guide you through
the data upload process.

Fig. 9: Add raster form

1.3.2 Uploading Medalus data

Different types of datasets have different fields based on their roles in the system. For example, all medalus datasets
must be associated with Aspect so that the system associates them with the computation modules for mebalus, see
figure 7.

1.3. Uploading and Manipulating data in the system 11
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1.3.3 Uploading Landsat data

Landsat rasters are relatively heavier in size per unit area, and should therefore be uploaded at country level. For
this reason, in addition to providing the basic information such as name and year, they must be associated with their
corresponding administrative level, e.g. admin level 0, see figure 8. Some of the datasets that are derived from landsat
satellite images include MSAVI, SAVI and NDVI. Uploading the other datasets Uploading the other dataset is very
similar to uploading Medalus dataset. LULC, Modis derived Vegetation indices, Carbon stock (SOC) and ecological
units dataset must be uploaded at the regional scale, i.e. one file for the whole of North African States.

1.4 Adding/editing Question

The Frontend of Misland provide a web page through which Frequently Asked Questions (FAQ) are displayed. The
Question option of the admin panel provides a user friendly tool through which FAQs can be managed. From here, new
FAQ can be added, outdated ones deleted or deactivated, and existing ones edited.

Fig. 10: Questions Section

Note that you can have several FAQs in the system but only display a few of them by activating and deactivating them.

Figure 11.

1.5 Modifying Gallery Items

The Gallery option on the admin panel is used to Upload new images on the homepage of Misland. The system is
designed in such a way that you do not need to delete old images, all you need to activate (check/uncheck is published)
the image you want displayed, and deactivate outdated images.

12 Chapter 1. MISLAND System Admin Panel
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Fig. 11: Publishing Gallery Intems

1.6 Managing Custom shapefile

This option enables the system administrator to view and manage all the custom shapefiles (Shapefiles uploaded by
individual users).

1.7 Computation Threshold

Computation thresholds are used to limit the amount of area that can be computed in real time within the system. This
is an important feature of the system as it enables the system administrator to manage the computing resources of the
system. There are two main thresholds that are set here; The Modis threshold, which applies to all dataset with spatial
resolution greater than 30m, and Landsat threshold, which apply to dataset with spatial resolution of 30m.

1.6. Managing Custom shapefile 13
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1.8 Managing Users

The admin panel provides tools for managing registered system users. Using this functionality, the system admin can
create new user, activate/deactivate existing user and assign different privileges to different them.

Fig. 12: Gallery

To modify the access rights of a particular system user, just click that user’s name on the system panel and implement
the desired changes. After the modification, just click the save button and the changes will take effect.

1.9 User Feedback

User feedback is sent to a github account for which the system admin can login and take appropriate action. User
feedback template is able to submit both text and images sent by the users of the system.

1.10 Google analytics

The system uses google analytics to track user visits to this online service. Some of the information google analytics
is able to provide include the number of visitors who are currently active on the system, the number of visits in a
particular period, the countries from which online traffic is coming from among other information. Figure 16 shows
sample information provided by google analytics. Google Analytics Link

14 Chapter 1. MISLAND System Admin Panel

https://analytics.google.com/analytics/web/?authuser=2#/report-home/a184032602w254258877p233620264


CHAPTER

TWO

DATA AND DATA SOURCES

MISLAND Africa draws on a number of data sources. The data sets listed below are owned/made available by the
following organizations and individuals under separate terms as indicated in their respective metadata.

2.1 NDVI

Sensor/Dataset Temporal Spatial Extent License
LANDSAT7 2001-2020 30 m Global Public Domain
MOD13Q1-coll6 2001-2016 250 m Global Public Domain

2.2 Soil moisture

Sensor/Dataset Temporal Spatial Extent License
MERRA 2 1980-2016 0.5° x 0.625° Global Public Domain
ERA I 1979-2016 0.75° x 0.75° Global Public Domain

2.3 Precipitation

Sensor/Dataset Temporal Spatial Extent License
GPCP v2.3 1 month 1979-2019 2.5° x 2.5° Global Public Domain
GPCC V6 1891-2019 1° x 1° Global Public Domain
CHIRPS 1981-2016 5 km 50N-50S Public Domain
PERSIANN-CDR 1983-2015 25 km 60N-60S Public Domain

15

https://developers.google.com/earth-engine/datasets/catalog/landsat
https://creativecommons.org/publicdomain/zero/1.0
https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod13q1_v006
https://creativecommons.org/publicdomain/zero/1.0
https://gmao.gsfc.nasa.gov/reanalysis/MERRA-Land
https://creativecommons.org/publicdomain/zero/1.0
https://www.ecmwf.int/en/forecasts/datasets/reanalysis-datasets/era-interim-land
https://creativecommons.org/publicdomain/zero/1.0
https://www.esrl.noaa.gov/psd/data/gridded/data.gpcp.html
https://creativecommons.org/publicdomain/zero/1.0
https://www.esrl.noaa.gov/psd/data/gridded/data.gpcc.html
https://creativecommons.org/publicdomain/zero/1.0
http://chg.geog.ucsb.edu/data/chirps
https://creativecommons.org/publicdomain/zero/1.0
http://chrsdata.eng.uci.edu
https://creativecommons.org/publicdomain/zero/1.0
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2.4 Evapotranspiration

Sensor/Dataset Temporal Spatial Extent License
MOD16A2 2000-2014 1 km Global Public Domain

2.5 Land cover

Sensor/Dataset Temporal Spatial Extent License
ESA CCI Land Cover 1992-2018 300 m Global CC by-SA 3.0

2.6 Soil carbon

Sensor/Dataset Temporal Spatial Extent License
Soil Grids (ISRIC) Present 250 m Global CC by-SA 4.0

2.7 Agroecological Zones

Sensor/Dataset Temporal Spatial Extent License
FAO - IIASA Global Agroecological Zones (GAEZ) 2000 8 km Global Public Domain

2.8 Soil Quality

Sensor/Dataset Temporal Spatial Extent License
Soil Texture and Depth Present 250 m Global CC by-SA 4.0
Parent Material Present N/A Global CC by-SA 4.0
Slope Present 30 m Global | JPL public

2.9 Climate

Sensor/Dataset Temporal Spatial Extent License
Terra Climate 1985-2019 30 m Global Public Domain

16 Chapter 2. Data and Data sources

https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod16a2_v006
https://creativecommons.org/publicdomain/zero/1.0
https://www.esa-landcover-cci.org
https://creativecommons.org/licenses/by-sa/3.0/igo
https://www.soilgrids.org/
https://creativecommons.org/licenses/by-sa/4.0
http://www.fao.org/nr/gaez/en
https://creativecommons.org/publicdomain/zero/1.0
https://cmr.earthdata.nasa.gov/search/concepts/C1000000240-LPDAAC_ECS.html
https://creativecommons.org/licenses/by-sa/4.0
https://doi.pangaea.de/10.1594/PANGAEA.788537
https://creativecommons.org/licenses/by-sa/4.0
https://developers.google.com/earth-engine/datasets/catalog/OpenLandMap_SOL_SOL_TEXTURE-CLASS_USDA-TT_M_v02
https://www.jpl.nasa.gov/imagepolicy/
https://developers.google.com/earth-engine/datasets/catalog/IDAHO_EPSCOR_TERRACLIMATE#description
https://creativecommons.org/publicdomain/zero/1.0
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2.10 Administrative Boundaries

Sensor/Dataset Temporal Spatial Extent License
Natural Earth Administrative Boundaries Present 10/50m Global Public Domain

Note: The Natural Earth Administrative Boundaries provided in MISLAND-North Africa are in the public domain.
The boundaries and names used, and the designations used, in MISLAND-North Africa do not imply official endorse-
ment or acceptance by Conservation International Foundation, or by its partner organizations and contributors.

If using MISLAND-North Africa for official purposes, it is recommended that users choose an official boundary pro-
vided by the designated office of their country.

2.10. Administrative Boundaries 17
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CHAPTER

THREE

DATA PREPARATION MODELS

3.1 The graphical modeler

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When working
with a GIS, most analysis operations are not isolated, rather part of a chain of operations. Using the graphical modeler,
that chain of operations can be wrapped into a single process, making it convenient to execute later with a different set
of inputs. No matter how many steps and different algorithms it involves, a model is executed as a single algorithm,
saving time and effort.

The graphical modeler can be opened from the Processing menu (Processing → Graphical Modeler).

The modeler has a working canvas where the structure of the model and the workflow it represents are shown. The left
part of the window is a section with five panels that can be used to add new elements to the model:

1. Model Properties: you can specify the name of the model and the group that will contain it

2. Inputs: all the inputs that will shape your model

3. Algorithms: the Processing algorithms available

4. Variables: you can also define variables that will only be available in the Processing Modeler

5. Undo History: this panel will register everything that happens in the modeler, making it easy to cancel things
you did wrong.

19
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Fig. 1: Modeler

Creating a model involves two basic steps:

1. Definition of necessary inputs. These inputs will be added to the parameters window, so the user can set their
values when executing the model. The model itself is an algorithm, so the parameters window is generated
automatically as for all algorithms available in the Processing framework.

2. Definition of the workflow. Using the input data of the model, the workflow is defined by adding algorithms and
selecting how they use the defined inputs or the outputs generated by other algorithms in the model.

3.1.1 Definition of inputs

The first step is to define the inputs for the model. The following elements are found in the Inputs panel on the left side
of the modeler window:

• Authentication Configuration

• Boolean

• Color

• Connection Name

• Coordinate Operation

• CRS

• Database Schema
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• Database Table

• Datetime

• Distance

• DXF Layers

• Enum

• Expression

• Extent

• Field Aggregates

• Fields Mapper

• File/Folder

• Geometry

• Map Layer

• Map Theme

• Matrix

• Mesh Dataset Groups

• Mesh Dataset Time

• Mesh Layer

• Multiple Input

• Number

• Point

• Print Layout

• Print Layout Item

• Range

• Raster Band

• Raster Layer

• Scale

• String

• TIN Creation Layers

• Vector Features

• Vector Field

• Vector Layer

• Vector Tile Writer Layers

Note: Hovering with the mouse over the inputs will show a tooltip with additional information.

When double-clicking on an element, a dialog is shown that lets you define its characteristics. Depending on the
parameter, the dialog will contain at least one element (the description, which is what the user will see when executing

3.1. The graphical modeler 21



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

the model). For example, when adding a raster data, as can be seen in the next figure, in addition to the description of
the parameter.

Fig. 2: Model Parameters Definition

You can define your input as mandatory for your model by checking the Mandatory option and by checking the
Advanced checkbox you can set the input to be within the Advanced section. This is particularly useful when the

model has many parameters and some of them are not trivial, but you still want to choose them.

The Comments tab allows you to tag the input with more information, to better describe the parameter. Comments are
visible only in the modeler canvas and not in the final algorithm dialog.

For each added input, a new element is added to the modeler canvas.

Fig. 3: Model Parameters

You can also add inputs by dragging the input type from the list and dropping it at the position where you want it in
the modeler canvas. If you want to change a parameter of an existing input, just double click on it, and the same dialog
will pop up.
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3.1.2 Definition of the workflow

In the following example we will add two inputs and two algorithms. The aim of the model is to copy the elevation
values from a DEM raster layer to a line layer using the Drape algorithm, and then calculate the total ascent of the line
layer using the Climb Along Line algorithm.

In the Inputs tab, choose the two inputs as Vector Layer for the line and Raster Layer for the DEM. We are now
ready to add the algorithms to the workflow.

Algorithms can be found in the Algorithms panel, grouped much in the same way as they are in the Processing toolbox.

Fig. 4: Model Inputs

To add an algorithm to a model, double-click on its name or drag and drop it, just like for inputs. As for the inputs you
can change the description of the algorithm and add a comment. When adding an algorithm, an execution dialog will
appear, with a content similar to the one found in the execution panel that is shown when executing the algorithm from
the toolbox. The following picture shows both the Mean PET and the Aridity Score algorithm dialogs.
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Fig. 5: Model Algorithm parameters

As you can see there are some differences.

You have four choices to define the algorithm inputs:

• Value: allows you to set the parameter from a loaded layer in the QGIS project or to browse a layer from a
folder

• Pre-calculated Value: with this option you can open the Expression Builder and define your own ex-
pression to fill the parameter. Model inputs together with some other layer statistics are available as variables
and are listed at the top of the Search dialog of the Expression Builder

• Model Input: choose this option if the parameter comes from an input of the model you have defined.
Once clicked, this option will list all the suitable inputs for the parameter

• Algorithm Output: is useful when the input parameter of an algorithm is an output of another algorithm

Algorithm outputs have the addditional Model Output option that makes the output of the algorithm available
in the model.

If a layer generated by the algorithm is only to be used as input to another algorithm, don’t edit that text box.

In the following picture you can see the two input parameters defined as Model Input and the temporary output layer:
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Fig. 6: Algorithm Input and Output parameters

In all cases, you will find an additional parameter named Dependencies that is not available when calling the algorithm
from the toolbox. This parameter allows you to define the order in which algorithms are executed, by explicitly defining
one algorithm as a parent of the current one. This will force the parent algorithm to be executed before the current
one.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However, in some
cases an algorithm might depend on another one even if it does not use any output object from it (for instance, an
algorithm that executes a SQL sentence on a PostGIS database and another one that imports a layer into that same
database). In that case, just select the previous algorithm in the Dependencies parameter and they will be executed in
the correct order.
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Once all the parameters have been assigned valid values, click on OK and the algorithm will be added to the canvas.
It will be linked to the elements in the canvas (algorithms or inputs) that provide objects that are used as inputs for the
algorithm.

Elements can be dragged to a different position on the canvas. This is useful to make the structure of the model more
clear and intuitive. You can also resize elements. This is particularly useful if the description of the input or algorithm
is long.

Links between elements are updated automatically and you can see a plus button at the top and at the bottom of each
algorithm. Clicking the button will list all the inputs and outputs of the algorithm so you can have a quick overview.

You can zoom in and out by using the mouse wheel.

Fig. 7: A complete model

You can run your algorithm any time by clicking on the button. In order to use the algorithm from the toolbox, it
has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

3.1.3 Interacting with the canvas and elements

You can use the , , and buttons to zoom the modeler canvas. The behavior of the buttons is basically
the same of the main QGIS toolbar.

The Undo History panel together with the and buttons are extremely useful to quickly rollback to a previous
situation. The Undo History panel lists everything you have done when creating the workflow.

You can move or resize many elements at the same time by first selecting them, dragging the mouse.

If you want to snap the elements while moving them in the canvas you can choose View → Enable Snapping.
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The Edit menu contains some very useful options to interact with your model elements:

• Select All: select all elements of the model

• Snap Selected Components to Grid: snap and align the elements into a grid

• Undo: undo the last action

• Redo: redo the last action

• Cut: cut the selected elements

• Copy: copy the selected elements

• Paste: paste the elements

• Delete Selected Components: delete all the selected elements from the model

• Add Group Box: add a draggable box to the canvas. This feature is very useful in big models to group elements
in the modeler canvas and to keep the workflow clean. For example we might group together all the inputs of the
example:

Fig. 8: Model Group Box
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You can change the name and the color of the boxes. Group boxes are very useful when used together with View →
Zoom To. This allows you to zoom to a specific part of the model.

You might want to change the order of the inputs and how they are listed in the main model dialog. At the bottom
of the Input panel you will find the Reorder Model Inputs... button and by clicking on it a new dialog pops up
allowing you to change the order of the inputs:

Fig. 9: Reorder Model Inputs

3.1.4 Saving and loading models

Use the Save model button to save the current model and the Open Model button to open a previously saved model.
Models are saved with the .model3 extension. If the model has already been saved from the modeler window, you
will not be prompted for a filename. Since there is already a file associated with the model, that file will be used for
subsequent saves.

Before saving a model, you have to enter a name and a group for it in the text boxes in the upper part of the window.

Models saved in the models folder (the default folder when you are prompted for a filename to save the model) will
appear in the toolbox in the corresponding branch. When the toolbox is invoked, it searches the models folder for files
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with the .model3 extension and loads the models they contain. Since a model is itself an algorithm, it can be added to
the toolbox just like any other algorithm.

Models can also be saved within the project file using the Save model in project button. Models saved using this method
won’t be written as .model3 files on the disk but will be embedded in the project file.

Project models are available in the Project models menu of the toolbox.

The models folder can be set from the Processing configuration dialog, under the Modeler group.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the Algorithms
tab of the modeler window. That means that you can incorporate a model as a part of a bigger model, just like other
algorithms.

Models will show up in the Browser panel and can be run from there.

Exporting a model as an image, PDF or SVG

A model can also be exported as an image, SVG or PDF (for illustration purposes) by clicking Export as image,
Export as PDF or Export as SVG.

3.1.5 Editing a model

You can edit the model you are currently creating, redefining the workflow and the relationships between the algorithms
and inputs that define the model.

If you right-click on an algorithm in the canvas, you will see a context menu like the one shown next:

Fig. 10: Modeler Right Click

Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only if
there are no other algorithms depending on it. That is, if no output from the algorithm is used in a different one as
input. If you try to remove an algorithm that has others depending on it, a warning message like the one you can see
below will be shown:
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Fig. 11: Cannot Delete Algorithm

Selecting the Edit. . . option will show the parameter dialog of the algorithm, so you can change the inputs and parameter
values. Not all input elements available in the model will appear as available inputs. Layers or values generated at a
more advanced step in the workflow defined by the model will not be available if they cause circular dependencies.

Select the new values and click on the OK button as usual. The connections between the model elements will change
in the modeler canvas accordingly.

The Add comment. . . allows you to add a comment to the algorithm to better describe the behavior.

A model can be run partially by deactivating some of its algorithms. To do it, select the Deactivate option in the context
menu that appears when right-clicking on an algorithm element. The selected algorithm, and all the ones in the model
that depend on it will be displayed in grey and will not be executed as part of the model.

Fig. 12: Model With Deactivated Algorithms

When right-clicking on an algorithm that is not active, you will see a Activate menu option that you can use to reactivate
it.

3.1.6 Editing model help files and meta-information

You can document your models from the modeler itself. Click on the Edit model help button, and a dialog like the one
shown next will appear.
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Fig. 13: Editing Help

On the right-hand side, you will see a simple HTML page, created using the description of the input parameters and
outputs of the algorithm, along with some additional items like a general description of the model or its author. The
first time you open the help editor, all these descriptions are empty, but you can edit them using the elements on the
left-hand side of the dialog. Select an element on the upper part and then write its description in the text box below.

Model help is saved as part of the model itself.
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3.1.7 Exporting a model as a Python script

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new Pro-
cessing algorithms can be created using Python. A quick way to create such a Python script is to create a model and
then export it as a Python file.

To do so, click on the Export as Script Algorithm. . . in the modeler canvas or right click on the name of the model in the

Processing Toolbox and choose Export Model as Python Algorithm. . . .
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FOUR

DATA SOURCES

MISLAND Africa draws on a number of data sources. The data sets listed below are owned/made available by the
following organizations and individuals under separate terms as indicated in their respective metadata.

4.1 NDVI

Sensor/Dataset Temporal Spatial Extent License
LANDSAT7 2001-2020 30 m Global Public Domain
AVHRR/GIMMS 1982-2015 8 km Global Public Domain
MOD13Q1-coll6 2001-2016 250 m Global Public Domain

4.2 Soil moisture

Sensor/Dataset Temporal Spatial Extent License
MERRA 2 1980-2016 0.5° x 0.625° Global Public Domain
ERA I 1979-2016 0.75° x 0.75° Global Public Domain

4.3 Precipitation

Sensor/Dataset Temporal Spatial Extent License
GPCP v2.3 1 month 1979-2019 2.5° x 2.5° Global Public Domain
GPCC V6 1891-2019 1° x 1° Global Public Domain
CHIRPS 1981-2016 5 km 50N-50S Public Domain
PERSIANN-CDR 1983-2015 25 km 60N-60S Public Domain
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4.4 Evapotranspiration

Sensor/Dataset Temporal Spatial Extent License
MOD16A2 2000-2014 1 km Global Public Domain

4.5 Land cover

Sensor/Dataset Temporal Spatial Extent License
ESA CCI Land Cover 1992-2018 300 m Global CC by-SA 3.0

4.6 Soil carbon

Sensor/Dataset Temporal Spatial Extent License
Soil Grids (ISRIC) Present 250 m Global CC by-SA 4.0

4.7 Agroecological Zones

Sensor/Dataset Temporal Spatial Extent License
FAO - IIASA Global Agroecological Zones (GAEZ) 2000 8 km Global Public Domain

4.8 Soil Quality

Sensor/Dataset Temporal Spatial Extent License
Soil Texture and Depth Present 250 m Global CC by-SA 4.0
Parent Material Present N/A Global CC by-SA 4.0
Slope Present 30 m Global | JPL public

4.9 Climate

Sensor/Dataset Temporal Spatial Extent License
Terra Climate 1985-2019 30 m Global Public Domain
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4.10 Administrative Boundaries

Sensor/Dataset Temporal Spatial Extent License
Natural Earth Administrative Boundaries Present 10/50m Global Public Domain

Note: The Natural Earth Administrative Boundaries provided in MISLAND-North Africa are in the public domain.
The boundaries and names used, and the designations used, in MISLAND-North Africa do not imply official endorse-
ment or acceptance by Conservation International Foundation, or by its partner organizations and contributors.

If using MISLAND-North Africa for official purposes, it is recommended that users choose an official boundary pro-
vided by the designated office of their country.
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FIVE

VEGETATION INDICES

5.1 MODIS NDVI

5.1.1 Data download from Google Earth Engine

The MOD13Q1 V6 product provides a Vegetation Index (VI) value at a per pixel basis. There are two primary veg-
etation layers. The first is the Normalized Difference Vegetation Index (NDVI) which is referred to as the continuity
index to the existing National Oceanic and Atmospheric Administration-Advanced Very High Resolution Radiometer
(NOAA-AVHRR) derived NDVI. The second vegetation layer is the Enhanced Vegetation Index (EVI) that minimizes
canopy background variations and maintains sensitivity over dense vegetation conditions. The MODIS NDVI and EVI
products are computed from atmospherically corrected bi-directional surface reflectances that have been masked for
water, clouds, heavy aerosols, and cloud shadows.

To compute and download the mean anual MODIS NDVI data from google earth engine. Open the Google Earth
Engine Code and paste the lines of code provided below

1 /**** Start of imports. If edited, may not auto-convert in the playground. ****/
2 var table = ee.FeatureCollection("users/derickongeri/NorthAfrica");
3 /***** End of imports. If edited, may not auto-convert in the playground. *****/
4 var dataset = ee.ImageCollection('MODIS/006/MOD13Q1')
5 .filter(ee.Filter.date('2018-01-01', '2019-01-01'))
6 .mean()
7 .clip(table);
8

9 var ndvi = dataset.select('NDVI');
10 var ndviVis = {
11 min: 0.0,
12 max: 8000.0,
13 palette: [
14 'FFFFFF', 'CE7E45', 'DF923D', 'F1B555', 'FCD163', '99B718', '74A901',
15 '66A000', '529400', '3E8601', '207401', '056201', '004C00', '023B01',
16 '012E01', '011D01', '011301'
17 ],
18 };
19 Map.centerObject(table);
20 Map.addLayer(ndvi, ndviVis, 'NDVI');
21

22 Export.image.toCloudStorage({
23 image:ndvi,
24 description: 'NDVI',
25 maxPixels:1e13,

(continues on next page)
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(continued from previous page)

26 scale:250,
27 bucket:'oss_ldms_vi',
28 region:table
29 })

5.2 Landsat derived NDVI, MSAVI, SAVI

5.2.1 Data download from Google Earth Engine

Several annual NDVI composite techniques have been discussed to overcome current Landsat 5 artifacts. MISLAND
uses annual NDVI products based on different percentiles in order to better qualify and quantify the Vegetation Loss
Index.

To compute and download desired percentile composites from google earth engine. Open the Google Earth Engine
Code and paste the lines of code provided below

1 // Required Data Inputs
2 // ===================
3 // * USGS/NASA's Landsat 4 surface reflectance tier 1 dataset (August 1982 -␣

→˓December 1993)
4 // * USGS/NASA's Landsat 5 surface reflectance tier 1 dataset (January 1, 1984 - May␣

→˓5, 2012)
5 // * USGS/NASA's Landsat 7 surface reflectance tier 1 dataset (January 1, 1999 -␣

→˓December 31, 2019)
6 // * USGS/NASA's Landsat 8 surface reflectance tier 1 dataset (April 11, 2013 -␣

→˓December 31, 2019)
7 // * Study Area Polygon
8

9 var countries = ee.FeatureCollection("USDOS/LSIB_SIMPLE/2017");
10

11 var Year='2002'
12

13

14 var country = 'Libya';
15 var ALGO = "PERCENTILE65"; // PERCENTILE75 // PERCENTILE65 // PERCENTILE60 //␣

→˓MEDIAN
16 var cloudCoveragePercentage = 80;
17

18

19 var studyArea = countries.filter(ee.Filter.eq('country_na',country ))
20 //Map.addLayer(studyArea);
21

22 /*
23 borders are quite coarse
24 var northAfrica = ee.FeatureCollection('users/derickongeri/Admin')
25 // Replace country name with EGYPT, LIBYA, ALGERIA, MAURITANIA, MOROCCO, TUNISIA
26 var country = 'TUNISIA';
27 var studyArea = northAfrica.filter(ee.Filter.eq('NAME', country))
28 Map.addLayer(studyArea);
29 */

(continues on next page)
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30

31

32

33

34 var start_date = Year+ '-01-01';
35 var end_date = Year+ '-12-31';
36

37

38 //--------------------------------------------------------------------
39 // Landsat 4, 5, 7 cloudmask
40 //--------------------------------------------------------------------
41

42 // If the cloud bit (5) is set and the cloud confidence (7) is high
43 // or the cloud shadow bit is set (3), then it's a bad pixel.
44 var cloudMaskL7 = function(image) {
45 var qa = image.select('pixel_qa');
46 var cloud = qa.bitwiseAnd(1 << 5)
47 .and(qa.bitwiseAnd(1 << 7))
48 .or(qa.bitwiseAnd(1 << 3));
49

50 // Remove edge pixels that don't occur in all bands
51 //var mask2 = image.mask().reduce(ee.Reducer.min())//.focal_min(300,'square','meters

→˓').eq(0);
52 //var mask2 = image.select('B4').reduce(ee.Reducer.min()).gt(0)//.focal_min(500,

→˓'square','meters');
53 // Remove edge pixels that don't occur in all bands
54 var mask3 =
55 (image.select('B3').gt(100))
56 .and(image.select('B4').gt(100))
57

58

59 .and(image.select('B4').lt(10000))
60 .and(image.select('B3').lt(10000))
61

62

63

64 return image.updateMask(cloud.not()).updateMask(mask3)//.updateMask(mask2)//.
→˓clip(image.geometry().buffer(-5000))//.or(mask3));

65 };
66

67

68 var cloudMaskL45 = function(image) {
69 var qa = image.select('pixel_qa');
70 var cloud = qa.bitwiseAnd(1 << 5)
71 .and(qa.bitwiseAnd(1 << 7))
72 .or(qa.bitwiseAnd(1 << 3));
73

74 // Remove edge pixels that don't occur in all bands
75 //var mask2 = image.mask().reduce(ee.Reducer.min());
76 var mask2 =
77 (image.select('B3').gt(100))
78 .and(image.select('B4').gt(100))

(continues on next page)
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79

80

81 .and(image.select('B4').lt(10000))
82 .and(image.select('B3').lt(10000))
83

84 return (image.updateMask(cloud.not()).updateMask(mask2))//.clip(image.geometry().
→˓buffer(-5000))//.updateMask(mask2);

85 };
86

87

88 //--------------------------------------------------------------------
89 // Landsat 8 cloudmask
90 //--------------------------------------------------------------------
91

92 // Bits 3 and 5 are cloud shadow and cloud, respectively.
93 function maskL8sr(image) {
94 var cloudShadowBitMask = (1 << 3);
95 var cloudsBitMask = (1 << 5);
96

97 // Get the pixel QA band.
98 var qa = image.select('pixel_qa');
99

100 // Both flags should be set to zero, indicating clear conditions.
101 var mask = qa.bitwiseAnd(cloudShadowBitMask).eq(0)
102 .and(qa.bitwiseAnd(cloudsBitMask).eq(0));
103 var mask2 =
104

105 (image.select('B5').gt(100))
106 .and(image.select('B4').gt(100))
107

108

109 .and(image.select('B5').lt(10000))
110 .and(image.select('B4').lt(10000))
111

112 //var mask2 = image.mask().reduce(ee.Reducer.min()).focal_min(500,'square','meters
→˓');

113 //return image
114 return image.updateMask(mask).updateMask(mask2)//.clip(image.geometry().buffer(-

→˓5000));
115 }
116

117

118

119

120 // Apply Cloudmask to L4.5.7
121 var L4 = ee.ImageCollection("LANDSAT/LT04/C01/T1_SR")
122 .filterDate(start_date, end_date)
123 .filter(ee.Filter.lessThan('CLOUD_COVER_LAND',␣

→˓cloudCoveragePercentage))
124 .filterBounds(studyArea)
125 .map(cloudMaskL45)
126 .select(['B3', 'B4'], ['RED', 'NIR']);;

(continues on next page)
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127

128 var L5 = ee.ImageCollection('LANDSAT/LT05/C01/T1_SR')
129 .filterDate(start_date, end_date)
130 .filter(ee.Filter.lessThan('CLOUD_COVER_LAND',␣

→˓cloudCoveragePercentage))
131 .filterBounds(studyArea)
132 .map(cloudMaskL45)
133 .select(['B3', 'B4'], ['RED', 'NIR']);;
134

135 var L7a = ee.ImageCollection('LANDSAT/LE07/C01/T1_SR')
136 .filterDate('1999-01-01', '2003-04-01')
137 .filterDate(start_date, end_date)
138 .filter(ee.Filter.lessThan('CLOUD_COVER_LAND', 100))
139 .filterBounds(studyArea)
140 .map(cloudMaskL7)
141 .select(['B3', 'B4'], ['RED', 'NIR']);;
142 var L7b = ee.ImageCollection('LANDSAT/LE07/C01/T1_SR')
143 .filterDate('2012-01-01', '2013-12-31')
144 .filterDate(start_date, end_date)
145 .filter(ee.Filter.lessThan('CLOUD_COVER_LAND', 100))
146 .filterBounds(studyArea)
147 .map(cloudMaskL7)
148 .select(['B3', 'B4'], ['RED', 'NIR']);;
149

150 var L7 = L7a.merge(L7b);
151

152 var L8 = ee.ImageCollection('LANDSAT/LC08/C01/T1_SR')
153 .filterDate(start_date, end_date)
154 .filter(ee.Filter.lessThan('CLOUD_COVER',␣

→˓cloudCoveragePercentage))
155 .filterBounds(studyArea)
156 //.filterBounds(AOI)
157 .map(maskL8sr)
158 .select(['B4', 'B5'], ['RED', 'NIR']);
159

160

161

162

163

164

165 //Define collection
166

167

168 //--------------------------------------------------------------------
169 // Merge Landsat 4, 5, 8 imagery collections and filter all by date/place
170 //--------------------------------------------------------------------
171

172 //Merge Landsat 4, 5 , 7 '
173

174 var L4578 = L4.merge(L5).merge(L7).merge(L8);
175

176

(continues on next page)
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177 //--------------------------------------------------------------------
178 // Create NDVI Collection
179 //--------------------------------------------------------------------
180

181 var NDVI = function(image) {
182 return image.normalizedDifference(['NIR', 'RED']).rename('NDVI');
183 //return image.addBands(ndvi);
184 };
185

186 if (ALGO=='MEDIAN'){
187 var suffix = 'median';
188 var annualNDVI = L4578.map(NDVI).median().clip(studyArea);
189 }
190

191 if (ALGO=='PERCENTILE75'){
192 var suffix = '75pc';
193 var annualNDVI = L4578.map(NDVI).reduce(ee.Reducer.percentile([75])).

→˓clip(studyArea);
194 }
195

196 if (ALGO=='PERCENTILE65'){
197 var suffix = '65pc';
198 var annualNDVI = L4578.map(NDVI).reduce(ee.Reducer.percentile([65])).

→˓clip(studyArea);
199 }
200

201

202 var ndvi_visualization = {
203 min: -0.22789797020331423,
204 max: 0.6575894075894075,
205 palette: 'FFFFFF, CE7E45, DF923D, F1B555, FCD163, 99B718, 74A901, 66A000, 529400,

→˓' +
206 '3E8601, 207401, 056201, 004C00, 023B01, 012E01, 011D01, 011301'
207 };
208 Map.addLayer(annualNDVI, ndvi_visualization, 'NDVI');
209

210 //--------------------------------------------------------------------
211 // Export as GeoTIFF
212 //--------------------------------------------------------------------
213

214

215 Export.image.toDrive({
216 image: annualNDVI,
217 description: country + '_NDVI_' + suffix + '_' + Year,
218 scale: 30,
219 region: studyArea,
220 maxPixels: 1e13,
221 fileFormat: 'GeoTIFF',
222 folder:'GEE_classification',
223 formatOptions: {
224 cloudOptimized: true
225 },

(continues on next page)
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(continued from previous page)

226 skipEmptyTiles: true
227 });
228

229 //Map.addLayer(L7.first(), {}, 'L7');
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CHAPTER

SIX

LANDCOVER DATA PREPARATION

MISLAND North Africa usese the European Space Agency (ESA) Climate Change Initiative (CCI) land cover dataset.
This dataset provides global maps describing the land surface into 22 classes, which have been defined using the United
Nations Food and Agriculture Organization’s (UN FAO) Land Cover Classification System (LCCS). In addition to the
land cover (LC) maps, four quality flags are produced to document the reliability of the classification and change
detection. In order to ensure continuity, these land cover maps are consistent with the series of global annual LC maps
from the 1990s to 2015 produced by the European Space Agency (ESA) Climate Change Initiative (CCI), which are
also available on the ESA CCI LC viewer.

The dataset can be downloaded here from the ESA C3S archives

6.1 Data Preprocessing Steps

1. Unzip the C3S-LC-L4-LCCS-Map-300m-P1Y-yyyy-v2.1.1 data from the compressed format that it comes in
after downloading. Closely examine the contents of this folder as it has various files.

Fig. 1: Rasters option on admin panel

2. Load the unzipped NetCDF4 raster onto qgis and select the lccs_class on the “Select Raster Layers to Add”
dialog.

45

https://developers.google.com/earth-engine/datasets/catalog/landsat


MISLAND DATA PREPARATION MANUAL, Release 0.0.1

Fig. 2: Extraction by mask

3. Once the raster layer is loaded add the vector layer of the OSS region and navigate to Raster > Extraction > Clip
Raster by Mask Layer
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Fig. 3: Finding the r.reclass processing tool

4. Once the raster layer has been clipped to the area of interest, open the processing toolbox and search for r.reclass
and select the GRASS>Raster>r.reclass tool.
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Fig. 4: Finding the r.reclass processing tool

5. On the r.reclass dialog that pops up, select the clipped land cover data as the input layer and paste the following
reclassification rules into the “Reclass rules text box” and save the output in a desired location.
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Fig. 5: Finding the r.reclass processing tool

6. Once the data is reclassified you can upload the QML style layer to visualize and validate the reclassified land
cover data.
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Fig. 6: Finding the r.reclass processing tool

6.2 Data Upload to MISLAND service

To upload the Land cover dataset to the admin panel. Follow these simple steps

1. Select the Rasters option from the list of options on the admin panel
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Fig. 7: Rasters option on admin panel

2 From the FILTER options, By raster type select LULC: Land use/land Cover option to view the list of Land cover
datasets that are already availabel on the database
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Fig. 8: Selecting Land cover option from the list of filters

3. Once you have confirmed that the raster you wish to add is not in the database. Select the ADD RASTER option
from the top-right conner of the admin panel.

Fig. 9: Selecting ‘ADD RASTER’ option
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4. On the add raster form that opens up, fill in the Name of the Land cover raster you with to add, then select the
Raster Year and the Raster Type as shown below:

Fig. 10: Filling the ADD RASTER form for land cover data upload

Note: It is recomended that you include the Year of the raster in the Name field as shown and that you associate the
Land cover raster with the LULC: Land use/land cover *Raster Type*for the system to work properly and point to the
right raster dataset.
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CHAPTER

SEVEN

FOREST LOSS

The High-resolution global forset change results from time-series analysis of Landsat images in characterizing global
forest extent and change.

The ‘first’ and ‘last’ bands are reference multispectral imagery from the first and last available years for Landsat spectral
bands 3, 4, 5, and 7. Reference composite imagery represents median observations from a set of quality-assessed
growing-season observations for each of these bands.

MISLAND North Africal uses the Hansen Global Forest Change v1.8 to asses forest loss in the North Africa action
zone. For more details of the Hansen Global Forest Change see the user notes

7.1 Data Preprocessing and Download on GEE

1. Open the Google Earth Engine Code and paste the following code to import the Hansen Global forest change
v1.8, OSS North Africa Action zone**(study area) and **Geometry for forest areas in North Africa.

1 var image = ee.Image("UMD/hansen/global_forest_change_2020_v1_8"),
2 table = ee.FeatureCollection("users/derickongeri/NorthAfrica"),
3 geometry =
4 /* color: #d63000 */
5 /* shown: false */
6 /* displayProperties: [
7 {
8 "type": "rectangle"
9 }

10 ] */
11 ee.Geometry.Polygon(
12 [[[-10.330249200933336, 37.60222178276082],
13 [-10.330249200933336, 31.415726509598066],
14 [24.562328924066662, 31.415726509598066],
15 [24.562328924066662, 37.60222178276082]]], null, false);

2. To select the forestLoss by year band and export the product paste the following code.

1 var dataset = image.clip(table);
2

3 var forestLoss = dataset.select('lossyear');
4

5 Map.addLayer(forestLoss);
6

7 Export.image.toDrive({
(continues on next page)
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(continued from previous page)

8 image: forestLoss,
9 description: 'ForestLoss',

10 scale: 30,
11 region: geometry,
12 maxPixels: 1e13,
13 fileFormat: 'GeoTIFF',
14 folder:'GEE_classification',
15 formatOptions: {
16 cloudOptimized: true
17 },
18 skipEmptyTiles: true
19 });

3. Save the code and run it to export the forestloss by year data.

7.2 Data Preprocessing in Qgis

1. Download the data form Google drive to your desired location on your local machine and load it to Qgis to view
the outputs.

Fig. 1: Opening the Forestloss year data on Qgis

2. On the Qgis menu-bar navigate to Raster>*Miscellaneous*>*Merge* to merge the downloaded tiles
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Fig. 2: Merging the Forestloss year data

1. On the Merge dialog, Input layers option choose the Select All option and click on OK.

7.2. Data Preprocessing in Qgis 57



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

Fig. 3: Selecting All layers to merge

save the output to a temporary layer so as to export it with desired properties in the next step.

4. Right click on the layer and navigate to Export>*Save as* option and save the layer to your desired location with
the appropriate name.

Note: The forest loss by year raster has values ranging from 1-20. The values represent the loss year form 2001 to
2020 hence to set the “nodata” value to 0 on the Save Raster Layer as dialog, check the No data values and input the
values as shown in the figure below:
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Fig. 4: Saving the Forest Loss year data
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7.3 Upload to MISLAND Service

Fig. 5: Uploading the data to MISLAND service
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CHAPTER

EIGHT

ECOLOGICAL UNITS LAYER

8.1 QGIS Data pre-processing steps

1. Open the land-cover and soil grids data on qgis

Fig. 1: Loading the Landcover and Soil Grids on Qgis

2. On the processing tool box, search for the EcologicalUnitsModel which will appear under Models>**Land
Productivity Models**
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Fig. 2: Finding the Ecological Unit Model

3. On the dialog that pops up, select the Landcover and the soil grid data as the input data and run the model
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Fig. 3: Ecological Unit Model dialog

Note:

Fig. 4: Ecological Unit Model summary
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It is important that the dimenssions of the Landcover data and the soil grids data are matching. This can be checked by
right clicking on the layer and navigating to properties>*Information*.

Fig. 5: Checking the dimenssions of the datasets

To match the dimensions of the two layers you can resample the soil grids to match the resolution of the Landcover
data.

4. On runing the model successfully the units layer will be loaded onto Qgis as shown below
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Fig. 6: Ecological Unit Model output

You can save the output from the Model to your desired location with the appropriate name
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Fig. 7: Saving the output
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8.2 Uploading the Ecological Units to MISLAND Service

Fig. 8: Data Upload Form
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CHAPTER

NINE

CLIMATE QUALITY INDEX

Climate quality is assessed on the basis of how it influences water availability to the plants. Consideration has been
given to the amount of rainfall, air temperature and aridity. Climate layers and relative scores are reported in Table 3. In
particular the selected layers are: Annual precipitation (a crucial parameter in plant growth); Bagnouls-Gaussen aridity
index (a synthesis of precipitation, evapotranspiration and run-off information); Slope aspect (affects microclimatic
conditions and erosion).

9.1 Data Preprocessing in Qgis

1. Open the downloaded Potential Evapotranspiration and Precipitation Datasets on Qgis.

Note: The two datasets are in NetCDF (Network Common Data Form) - a file format for storing multidimensional
scientific data (variables) such as temperature, humidity, pressure, wind speed, and direction. Each of these variables
can be displayed through a dimension (such as time) by making a layer or table view from the netCDF file. When
loading the precipitation data select the ppt option on the Select Raster Layers to Add dialog that pops up.
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Fig. 1: Selecting the Precipitation data to add to Qgis

The loaded layers, alongside the OSS North Africa action zone shapefile should appear on the layers panel on Qgis as
shown below
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Fig. 2: Loading the PPT and PET NetCDF files to Qgis

2. Clip the layers to the desires study area by navigating to Raster>*Extraction*>*Clip Raster by Mask Layer*
option on the Qgis Menu bar.
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Fig. 3: Clipping by Mask Layer

On the dialoge that pops up select the inputs as shown and specify the Source CRS and target CRS options as shown
below. Save the outputs to your desired location before running the tool.
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Fig. 4: Clipping by Mask Layer

3. Once the layers are successfully cliped and saved, open the Processing toolbox and type “Climate Quality Index”
and select the Climate Quality Index moded under Models
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Fig. 5: Climate Quality Index model

Select the proper inputs for the Potential Evapotranspiration and the Precipitation
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Fig. 6: Defining Inputs for the CQI model

Note: The CQI Model yeilds the Precipitation Index by computing the total annual precipitation and reclassifying the
values. The Aridity Index is computed as the ration of the Mean annual precipitation and the potential evapotranspira-
tion using the simple Penman-Monteith formulae. The process is as summarized in the graphical representation of the
model shown below.
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Fig. 7: CQI Model graphical model

The classes for the precipitation and aridity index are obtained from: Ferrara, A*., Kosmas, C., Salvati, L.,
Padula, A., Mancino, G., & Nolè, A. (2020). Updating the MEDALUS-ESA Framework for Worldwide
Land Degradation and Desertification Assessment. Land Degradation & Development, 31(12), 1593-
1607.

Fig. 8: Aridity Index and Precipitaiton index scores

4. Once the model has been executed successfully, The ouputs will be loaded onto Qgis. Right click on the tempo-
rary layer and navigate to the Save as option to to export the layers with the desired Name, CRS and dimensions
as shown below;
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Fig. 9: CQI Model graphical model outputs
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Fig. 10: Saving the outputs

Note: On the horizontal and vertical resolution setings in the Save as dialog paset the value 0.0027778 for each of the
outpus to give the layers a resolution 0f 300m to match other variables for computing the desertification indicators
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Fig. 11: Setting the resolution of the output layers layers

9.2 Uploading the Arididy Index to MISLAND Service

Note: It is important that you give the Aridity Index layer a descriptive name and assocciate it with the correct year
and raster category as shown below.
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Fig. 12: Aridity index data upload

9.3 Uploading the Rainfall Data to MISLAND Service
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CHAPTER

TEN

VEGETATION QULALITY INDEX

Vegetation plays a key role in preventing desertification by providing shelter against wind and water erosion. Plant
cover promotes infiltration of water and reduces runoff, residual plant materials from senescent vegetation enriches the
soil with organic matter which improves its structure and cohesion . The preliminary classification and the assigned
scores of the vegetation characteristics is as summarized in the table below:

Sensor/Dataset Temporal Spatial Extent License
ESA CCI Land Cover 1992-2018 300 m Global CC by-SA 3.0
PROBAV NDVI 2013-present 100 m Global Public Domain

10.1 Compute and download PROBAV maxNDVI form Google Earth
Engine

To compute and download PROBAV maximum NDVI composite from google earth engine. Open the Google Earth
Engine Code and paste the lines of code provided below

1 //Import the Proba-V data and North Africa region geometry
2

3 var imageCollection = ee.ImageCollection("VITO/PROBAV/C1/S1_TOC_100M"),
4 table2 = ee.FeatureCollection("users/derickongeri/NorthAfrica");
5

6 //filet the image collection by year, compute the maximum NDVI, and clip to the study␣
→˓area

7 var filteredCollection = imageCollection.filterDate('2018-01-01','2019-01-01')
8 .max()
9 .clip(table2);

10

11 var ndviImage = filteredCollection.select('NDVI');
12

13 Map.addLayer(ndviImage.randomVisualizer());
14

15 //Export the data to drive
16 Export.image.toDrive({
17 image: ndviImage,
18 description: 'NDVI_Max_2018',
19 maxPixels: 1e13,
20 scale: 100,
21 region: table2
22 })
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10.2 Data Preprocessing in Qgis

1. Open the cliped landcover data(all 36 classes) and the ProbaV maximum NDVI composite data on Qgis

Fig. 1: Landcover data and NDVI data loaded to Qgis

2. Once the layers are loaded on to Qgis, open the processing toolbox and search for ‘Vegetation Quality Index’ in
the search bar. The vegetatioon quality index model should show up under the Models section as shown. Click
on the Model to open it.

Fig. 2: Vegetation Quality Index processing Model
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3. On the Vegetation Quality Index dialog that pops up, select the loaded landcover and NDVI data as inputs and
run the model

Fig. 3: Vegetation Qulity Index inputs

Note: The vegetation Quality Index model Reclassifies the landcover and assigns scores to the landcover groups for
the Fire Risk, Erosion Protection and the Drought resistance. The plant cover is derived from the Maximum NDVI
composite as summarized in the graphical model below.
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Fig. 4: Vegetation Qulity Index inputs

The scores to the reclassified landcover outputs and plant cover scores are assigned according to the table below: Fer-
rara, Agostino, et al. “Updating the MEDALUS-ESA Framework for Worldwide Land Degradation and Desertification
Assessment.” Land Degradation & Development 31.12 (2020): 1593-1607.
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Fig. 5: Vegetation Qulity Index inputs

Fig. 6: Plant cover scores

4. On running the model the ouputs for the elementary VQI variables should be loaded onto QGIS as temporary
layers. Save the layers to your desired folder with the appropriate descriptive name.
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Fig. 7: Vegetation Qulity Index model outputs

Note: To save the layers with the appropriate dimensions, right click on the layer you want to save and navigate to
Export>*Save as* and on the Save as dialog set the appropriate name and location for the output. Make sure to set the
horizontal and vertical resolution option to 0.00277778 for all the outputs as shown below.
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Fig. 8: Vegetation Qulity Index model outputs

10.3 Data Upload to MISLAND service
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ELEVEN

SOIL QUALITY INDEX
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CHAPTER

TWELVE

MANAGEMENT QULITY INDEX

12.1 Data Preprocessing in Qgis

1. Open the downloaded country population density data on Qgis as shown in the figure so as to merge them

Fig. 1: Opening Land cover and population data on Qgis

2. On the Qgis Menu-bar, navigate to Raster>Miscelleneous>Merge as shown below:
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Fig. 2: Merging Population Dataset

3. On the dialog that pops-up, click on the Input Layer selection option and choose Select All
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Fig. 3: Merge layers dialog
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Fig. 4: Selecting population datasets to merge

Save the merged layer to your desired location.

4. With the output from step 3 above loaded onto Qgis, Load the landcover data for the same year as the population
data
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Fig. 5: Load the Landcover data on Qgis

5. Once the layers are loaded on to Qgis, open the processing toolbox and search for ‘Management Quality Index’
in the search bar. The management quality index model shoul show up under your the Models section as shown.
Click on the Model to open it.

Fig. 6: Accessing the MQI model from the processing toolbox

6. Select the Landcover and Population dataset as your model inputs on the dialog that pops up as shown below:
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Fig. 7: Selecting Imput parameters for the MQI model

Note: According to the major land use types for assessing the management quality degree of human induced stress,
the land use intensity is obtained by defining the type of land use in a certain piece of land using the land cover. The
population density was used as a proxy of human pressure on the environment: Ferrara, A*., Kosmas, C., Salvati,
L., Padula, A., Mancino, G., & Nolè, A. (2020). Updating the MEDALUS-ESA Framework for Worldwide Land
Degradation and Desertification Assessment. Land Degradation & Development, 31(12), 1593-1607.

The simplified methodology is as represnted in the workflow below:
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Fig. 8: Management Quality Index Model summary

Fig. 9: Land use intensity score

12.1. Data Preprocessing in Qgis 97



MISLAND DATA PREPARATION MANUAL, Release 0.0.1

Fig. 10: Population density score

6. Once the model is executed successfully the outputs will be loaded as temporary layers. You can save the layers
with the desired name and set the horizontal and vertical resolution option to 0.0027778

Fig. 11: Management Quality Index model outputs
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Fig. 12: Saving the Outputs of the MQI model

12.2 Uploading the data to MISLAND Service
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THIRTEEN

SOIL ORGANIC CARBON
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CHAPTER

FOURTEEN

COASTAL VULNERABILITY INDEX

The index integrates six physical variables in a quantifiable way to reflect the coast’s relative vulnerability to physical
changes caused by sea-level rise. This method produces numerical data that cannot be immediately correlated to
specific physical effects. However, it does emphasize the areas where the various effects of sea-level rise may be the
most severe.

Fig. 1: Ranking of the coastal vulnerability index variables

Once each section of coastline is assigned a risk value for each specific data variable, the coastal vulnerability index is
calculated as the square root of the geometric mean of these values divided by the total number of variables.
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14.1 Data Download

The data was downloaded from different platforms which included the Google Earth Engine platform, Global litholog-
ical dataset and the Ecological coastal units site based on the variable in question.

14.1.1 Data Processing Steps

14.1.2 Geomorphology

The Geomophological dataset was downloaded from the global lithological portal given below; Global lithological
dataset.

It was then subset to the generated study area map of the North Africa region. On the layer styling panel, symbolize
the data into 5 classes using the discrete interpolation and then use the interpolation output to classify the data into five
classes to give them the degree of erosivity using the qgis reclassify by table tool as shown the the figure below;
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Fig. 2: Layer Styling
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Fig. 3: Geomophology reclassify by table

The result of the re-classification should be 5 classes with a risk value of 5 classes whereby value 1 is very low and
value 5 is very high.

Fig. 4: Geomophology Erosivity Classes
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14.2 Upload to MISLAND Service

Fig. 5: Uploading the data to MISLAND service

14.2.1 Coastal Slope

Download the elevation raster file from Google Earth Engine Subset to the North Africa coastal region using the region’s
shapefile. To compute slope, Open Qgis > Raster > Analysis > Slope. The slope computation window opens as shown
below:
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Fig. 6: Slope Computation

After a successful slope computation, symbolize the it using the discrete interpolation method in Qgis software and
then reclassify it into five classes using the Qgis reclassify by table tool.

Fig. 7: Slope ranked classes

Note

The class ranges should be obtained from the layer styling value label whereby the lowest is assigned value 1 whereas
the highest is assigned value 5.
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Fig. 8: Uploading the data to MISLAND service

14.2.2 Tidal Range

Download the data from the Coastal Ecological Units (ECU) The data comes as a shapefile with different data attributes
of 10 variables. First convert the data into a raster using the Rasterize GDAL tool in Qgis. Remember to change the
burn-in field value to TIDAL RANGE. Leave the other options as default and click run.
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Fig. 9: Tidal Range Raster Conversion

Next is to reclassify the data and assign the class ranges as it was done in the Geomophology data preparation.
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Fig. 10: Uploading the data to MISLAND service

14.2.3 Wave Height

Download the data from global wave statistics, and subset it to the North Africa coast region. Follow the same procedure
as the one used in the Geomophology data preparation. to classify the data and rank into into 5 categorical classes.
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Fig. 11: Uploading the data to MISLAND service

14.2.4 Shoreline Erosion

Download the data from the Coastal Ecological Units (ECU) and then follow the procedure as the one given in Tidal
Range data preparation.
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Fig. 12: Uploading the data to MISLAND service
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14.2.5 Sea Level Rise

Fig. 13: Uploading the data to MISLAND service
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